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1. การกรอกขอมูลจากแบบสอบถามโดยใชโปรแกรม SPSS  

1.1 ทําการเปดโปรแกรม SPSS ข้ึนมาเพื่อใชงาน 

 

1.2 กรอกขอมลูจากแบบสอบถามที่ไดรบัจากการเก็บรวบรวมขอมูล โดยกําหนดกลุมตัวแปรในสวนของ  

Variable View 
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1.3 กรอกขอมลูจากแบบสอบถามที่ไดรบัจากการเก็บรวบรวมขอ ในสวนของ Data View 
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2. การหาคารอยละ (Frequencies)   

2.1 เริ่มตนการหาคารอยละของตัวแปรเพศ สถานะ วุฒิการศึกษา อาย ุและการประเมินผลรายขอ   

2.1.1 ไปเลือกที่เมนู  Analyze > Descriptive Statisticals > Frequencies   
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2.1.2 จากน้ันทําการเลอืกตัวแปรที่ตองการหาคารอยละ โดยเลือกตัวแปรทกุตัวแปร               

แลวคลิกลกูศร เพือ่เลือกไปยังชองวางดานขวามือ 

 

2.1.3 หลังจากทีท่ําการเลอืกแลวกดลูกศรแลว กลุมตัวแปรที ่Variable(s); ดังภาพ แลวคลิกที่ Statistics เพื่อ

ระบุคาที่ตองการทราบวาตองการทราบคา 
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2.1.4 ทําการเลือกคา Mean และ SD แลวคลิก Continue (โดยคาที่เราตองการทราบในที่น้ีคือ 

(Frequencies)   

 

 

2.1.5 จะไดผลการแปลผลคารอยละของทุกตัวแปร 
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2.2 การหาคารอยละรายขอและรวม  

ทําการกําหนดกลุมเพื่อหาคารอยละรวมรายขอกอน โดยไปที่เมนู Transform > Compute Variable…  

ดังภาพ 

2.2.1 กําหนดคาขอมูล ดังภาพ   

 Target Variable = ต้ังช่ือวา Totale   

 Function and Special Variables: = เลือก SUM   

 ในชอง Numeric Expression จะปรากฏขอความข้ึนมาคําวา SUM(?,?)/N  โดยภายใน 

 เครื่องหมาย ? น้ันใหเราเลือกชวงของคาที่ตองการกําหนดชวงในการหาผล E1, E4 น้ันหมายถึง ขอที่ 

1.1 – ขอ 1.4 
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2.2.2 SUM (e1, e4)/4 คือ ขอคําถามขอที ่1.1 – 1.4 ที่เราตองการหาคาเฉลี่ย จะไดคาเฉลี่ยในชอง Totale  

 

2.2.2 ทําแบบเดียวกัน ในทุกตัวแปร e, f, g, h ทําใหไดตัวแปรเพิ่มคือ Totale, Totalf, Totalg, Totalh 
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2.2.3  กําหนดคาขอมลูรวมของตัวแปรทกุตัว sumtotal ดังภาพ   

 Target Variable = ต้ังช่ือวา sumtotal  

 Function and Special Variables: = เลือก SUM   

 ในชอง Numeric Expression จะปรากฏขอความข้ึนมาคําวา SUM(?,?)/N  โดยภายใน 

 เครื่องหมาย ? น้ันใหเราเลือกชวงของคาที่ตองการกําหนดชวงในการหาผลในตัวแปรทุกตัว น้ัน

หมายถึง ขอที่ 1.1 – ขอ 5 (ยกเวนขอ 4.1 หรือ h1 เน่ืองจากเปนขอมูลกอนการอบรม) 

 

2.2.3 ทําใหไดตัวแปรเพิ่มคือ sumtotal 
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3.การหาคาเฉลี่ยและคาเบ่ียงเบนมาตรฐานของคําถามแตละขอ (คําถามขอ 1 – ขอ 4)  

3.1 เลือกเมนู Analyze > Descriptive Statisticals > Descriptives 

 

3.2 เลือกตัวแปร Totale, Totalf, Totalg, Totalh และ sumtotal แลวคลิกลกูศรเลือกมายังกลอง 

Variable(s); และคลิกเลือกเครื่องหมาย  ในชอง Frequency ออก 
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3.3 จากน้ันคลิกทีปุ่ม Statistics เพื่อคลิกเลือกคาที่ตองการทราบ ในที่น้ีเราตองเลือกคาเฉลี่ย (Mean) และ 

คาเบี่ยงเบนมาตรฐาน (SD) ก็ทําการคลกิเลือกคาทัง้สองคาที่ตองการทราบ หากคาใดที่ไมตองติกเครื่องหมาย 

� หนาชองน้ันออก จากน้ันคลิกปุม Continue 

 

3.4 คลิกปุม OK 
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3.5 เสรจ็แลวกจ็ะทราบคาเฉลี่ย (ݔ ̅) และคาเบี่ยงเบนมาตรฐาน (SD) 

 

4. การบันทึก (SAVE) ขอมูล Data View เพ่ือเก็บไวใชในการประมวลผล  

4.1 ไปที่เมนู File > Save , Save As… 

 

4.2 ต้ังช่ือไฟล ในชอง File name :   จากน้ันกดปุม Save 
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4.3 จากน้ันนํา output ที่ไดมาวิเคราะหขอมลูตอไป 

 

 

 

ภาคผนวก 

 

ตัวอยาง output จาก SPSS 

 
Frequencies 

 

 

 

 

Statis 

 

Frequency Table 

 

 E1 E2 E3 E4 F1 F2 F3 F4 G1 G2 G3 H1 H2 H3 H4 H5 H6 I 

N Valid 
17 17 17 17 17 17 17 17 17 17 17 17 17 16 17 17 17 17 

 Missi

ng 
0 0 0 0 0 0 0 0 0 0 0 0 0 1 0 0 0 0 

Mean 
4.1765 4.4706 4.2941 4.3529 4.7647 4.7059 4.6471 4.7647 4.2353 4.2941 4.5882 2.5882 4.1176 4.1875 4.1176 4.0000 4.0000 4.2941 

Std. Deviation 
.63593 .62426 .68599 .60634 .43724 .46967 .49259 .43724 .75245 .68599 .50730 .71229 .69663 .75000 .78121 .70711 .50000 .58787 
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A 

 

 Frequency Percent Valid Percent 

Cumulative 

Percent 

Valid 1.00 4 23.5 23.5 23.5 

2.00 13 76.5 76.5 100.0 

Total 17 100.0 100.0  

 

 

B 

 

 Frequency Percent Valid Percent 

Cumulative 

Percent 

Valid 1.00 5 29.4 29.4 29.4 

2.00 12 70.6 70.6 100.0 

Total 17 100.0 100.0  

 

 

 

 

 

 

 

C 

 

 Frequency Percent Valid Percent 

Cumulative 

Percent 

Valid 1.00 1 5.9 5.9 5.9 

2.00 7 41.2 41.2 47.1 

3.00 7 41.2 41.2 88.2 

4.00 2 11.8 11.8 100.0 

Total 17 100.0 100.0  

 

 

D 

 

 Frequency Percent Valid Percent 

Cumulative 

Percent 
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Valid 1.00 2 11.8 11.8 11.8 

2.00 8 47.1 47.1 58.8 

3.00 5 29.4 29.4 88.2 

4.00 1 5.9 5.9 94.1 

5.00 1 5.9 5.9 100.0 

Total 17 100.0 100.0  

 

 

E1 

 

 Frequency Percent Valid Percent 

Cumulative 

Percent 

Valid 3.00 2 11.8 11.8 11.8 

4.00 10 58.8 58.8 70.6 

5.00 5 29.4 29.4 100.0 

Total 17 100.0 100.0  

 

 

 

 

 

 

 

 

 

E2 

 

 Frequency Percent Valid Percent 

Cumulative 

Percent 

Valid 3.00 1 5.9 5.9 5.9 

4.00 7 41.2 41.2 47.1 

5.00 9 52.9 52.9 100.0 

Total 17 100.0 100.0  

 

 

E3 
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 Frequency Percent Valid Percent 

Cumulative 

Percent 

Valid 3.00 2 11.8 11.8 11.8 

4.00 8 47.1 47.1 58.8 

5.00 7 41.2 41.2 100.0 

Total 17 100.0 100.0  

 

 

E4 

 

 Frequency Percent Valid Percent 

Cumulative 

Percent 

Valid 3.00 1 5.9 5.9 5.9 

4.00 9 52.9 52.9 58.8 

5.00 7 41.2 41.2 100.0 

Total 17 100.0 100.0  

 

 

F1 

 

 Frequency Percent Valid Percent 

Cumulative 

Percent 

Valid 4.00 4 23.5 23.5 23.5 

5.00 13 76.5 76.5 100.0 

Total 17 100.0 100.0  

 

 

F2 

 

 Frequency Percent Valid Percent 

Cumulative 

Percent 

Valid 4.00 5 29.4 29.4 29.4 

5.00 12 70.6 70.6 100.0 

Total 17 100.0 100.0  

 

 

F3 
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 Frequency Percent Valid Percent 

Cumulative 

Percent 

Valid 4.00 6 35.3 35.3 35.3 

5.00 11 64.7 64.7 100.0 

Total 17 100.0 100.0  

 

 

F4 

 

 Frequency Percent Valid Percent 

Cumulative 

Percent 

Valid 4.00 4 23.5 23.5 23.5 

5.00 13 76.5 76.5 100.0 

Total 17 100.0 100.0  

 

 

G1 

 

 Frequency Percent Valid Percent 

Cumulative 

Percent 

Valid 3.00 3 17.6 17.6 17.6 

4.00 7 41.2 41.2 58.8 

5.00 7 41.2 41.2 100.0 

Total 17 100.0 100.0  

 

 

 

 

 

G2 

 

 Frequency Percent Valid Percent 

Cumulative 

Percent 

Valid 3.00 2 11.8 11.8 11.8 

4.00 8 47.1 47.1 58.8 

5.00 7 41.2 41.2 100.0 
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Total 17 100.0 100.0  

 

 

G3 

 

 Frequency Percent Valid Percent 

Cumulative 

Percent 

Valid 4.00 7 41.2 41.2 41.2 

5.00 10 58.8 58.8 100.0 

Total 17 100.0 100.0  

 

 

H1 

 

 Frequency Percent Valid Percent 

Cumulative 

Percent 

Valid 1.00 1 5.9 5.9 5.9 

2.00 6 35.3 35.3 41.2 

3.00 9 52.9 52.9 94.1 

4.00 1 5.9 5.9 100.0 

Total 17 100.0 100.0  

 

 

H2 

 

 Frequency Percent Valid Percent 

Cumulative 

Percent 

Valid 3.00 3 17.6 17.6 17.6 

4.00 9 52.9 52.9 70.6 

5.00 5 29.4 29.4 100.0 

Total 17 100.0 100.0  

 

 

H3 

 

 Frequency Percent Valid Percent 

Cumulative 

Percent 
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Valid 3.00 3 17.6 18.8 18.8 

4.00 7 41.2 43.8 62.5 

5.00 6 35.3 37.5 100.0 

Total 16 94.1 100.0  

Missing System 1 5.9   

Total 17 100.0   

 

 

H4 

 

 Frequency Percent Valid Percent 

Cumulative 

Percent 

Valid 3.00 4 23.5 23.5 23.5 

4.00 7 41.2 41.2 64.7 

5.00 6 35.3 35.3 100.0 

Total 17 100.0 100.0  

 

 

H5 

 

 Frequency Percent Valid Percent 

Cumulative 

Percent 

Valid 3.00 4 23.5 23.5 23.5 

4.00 9 52.9 52.9 76.5 

5.00 4 23.5 23.5 100.0 

Total 17 100.0 100.0  

 

 

 

 

 

 

 

 

 

 

 

H6 
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 Frequency Percent Valid Percent 

Cumulative 

Percent 

Valid 3.00 2 11.8 11.8 11.8 

4.00 13 76.5 76.5 88.2 

5.00 2 11.8 11.8 100.0 

Total 17 100.0 100.0  

 

 

I 

 

 Frequency Percent Valid Percent 

Cumulative 

Percent 

Valid 3.00 1 5.9 5.9 5.9 

4.00 10 58.8 58.8 64.7 

5.00 6 35.3 35.3 100.0 

Total 17 100.0 100.0  

 

 

 

Statistics 

 

 SUME SUMF SUMG SUMH I SUMTOTAL 

N Valid 17 17 17 17 17 17 

Missing 0 0 0 0 0 0 

Mean 4.3235 4.7206 4.3725 3.7941 4.2941 4.2388 

Std. Deviation .54317 .42281 .57593 .55129 .58787 .43993 
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ตัวอยางการนํา output จากโปรแกรม SPSS มาวิเคราะหขอมูล และสรุปผลการประเมิน 

“โครงการแลกเปล่ียนเรียนรู เรื่องการพัฒนาแผนกลยุทธ: 

 การกระจายตัวช้ีวัดสูระดับรายบุคคล”  

วันศุกรที่ 16 กันยายน 2559  เวลา 9.00 – 16.00 น.  

ณ หองประชุม ศศ.รส.211 ช้ัน 2 คณะศิลปศาสตร ศูนยรังสิต   

…………………………………………… 

 

ตอนที่ 1 ขอมูลทั่วไปของผูเขารวมโครงการ 

 

เพศ 

 กลุมตัวอยางกลุมน้ี มีสัดสวนของเพศหญงิมากกวาเพศชาย คือ เพศหญิง รอยละ 76.5 และเพศชาย รอยละ 

23.5 ดังตารางท่ี 1 

ตารางท่ี 1 

รอยละและจํานวนของกลุมตัวอยางจําแนกตามเพศ ( N = 17) 

เพศ รอยละ จํานวน 

ชาย 

หญงิ 

23.5 

76.5 

4 

13 

รวม 100 17 

 

สถานะ 

 กลุมตัวอยางกลุมน้ี มีสัดสวนของบุคลากรมากกวาอาจารย คือ บุคลากร รอยละ 70.6 และอาจารย รอยละ 

29.4 ดังตารางท่ี 2 

ตารางท่ี 2 

รอยละและจํานวนของกลุมตัวอยางจําแนกตามสถานะ ( N = 17) 

สถานะ รอยละ จํานวน 

อาจารย 

บุคลากร 

29.4 

70.6 

5 

12 

รวม 100 17 

 

วุฒิการศึกษา 
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กลุมตัวอยางกลุมน้ี สวนใหญมีวุฒิการศึกษาระดับปริญญาตรี และปริญญาโท เทากันท่ีรอยละ 41.2 

รองลงมาระดับปริญญาเอก รอยละ 11.8 ดังตารางท่ี 3 

 

 

 

 

 

ตารางท่ี 3 

รอยละและจํานวนของกลุมตวัอยางจําแนกตามวุฒิการศึกษา ( N = 17) 

วุฒิการศึกษา รอยละ จํานวน 

ต่ํากวาปริญญาตรี  

ปริญญาตรี 

ปริญญาโท 

ปริญญาเอก 

5.9 

41.2 

41.2 

11.8 

1 

7 

7 

2 

รวม 100.0 17 

 

อาย ุ

กลุมตัวอยางกลุมน้ี สวนใหญชวงอายุ 30 - 40 ป รอยละ 47.1 ดังตารางท่ี 4 

ตารางท่ี 4 

รอยละและจํานวนของกลุมตัวอยางจําแนกตามอาย ุ( N = 17) 

ชวงอาย ุ รอยละ จํานวน 

ต่ําวา 30 ป  11.8  2 

30 - 40 ป 47.1 8 

40 - 50 ป 29.4 5 

50 - 60 ป 5.9 1 

60 ปขึ้นไป 5.9 1 

รวม 100 17 

 

 

ตอนที่ 2 ระดับความพึงพอใจเกี่ยวกบัการจัดโครงการในดานตางๆ 

 

ความรูความเขาใจเกี่ยวกับหัวขอเรื่อง กอน การจัดโครงการ 

 จํานวนการตอบของกลุมตัวอยาง พบวา ความรูความเขาใจเก่ียวกับหัวขอเร่ือง กอน การเขารวมโครงการ 

ในภาพรวมอยูในระดับปานกลาง ( x = 2.59) ดังตารางท่ี 5 
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ตารางท่ี 5 

ความรูความเขาใจเก่ียวกับหัวขอเร่ือง กอน เขารวมโครงการ (N = 17) 

รายการ ระดับความพึงพอใจ1 x  ความหมาย 

มากท่ีสุด มาก ปานกลาง นอย นอย

ท่ีสุด 

4.1 ความรูความเขาใจ

เก่ียวกับหัวขอเร่ือง 

กอน เขารวมโครงการ 

- 5.9 

(1) 

35.3 

(9) 

52.9 

(6) 

5.9 

(1) 

2.59 ปานกลาง 

 

ผูตอบแบบสอบถามมีระดับความพึงพอใจเก่ียวกับโครงการ “โครงการแลกเปลี่ยนเรียนรู เร่ืองการ

พัฒนาแผนกลยุทธ: การกระจายตัวชี้วัดสูระดับรายบุคคล” ในภาพรวมอยูในระดับมาก ( x = 4.24) เม่ือพิจารณา

ความพึงพอใจรายดาน พบวาความพึงพอใจเก่ียวกับเจาหนาท่ีผูใหบริการ/วิทยากร/ผูประสานงานไดรับความพึงพอใจ

สูงสุด ( x = 4.72)  

  เม่ือพิจารณาในรายละเอียด ดานกระบวนการ ขั้นตอนการใหบริการ พบวาความเหมาะสมของ

สถานท่ีมีความเหมาะสมสูงสุด ( x = 4.47) สวนความพึงพอใจดานเจาหนาท่ีผูใหบริการ/วิทยากร/ผูประสานงาน 

พบวาความพึงพอใจตอเร่ือง ความรอบรู ในเน้ือหาของวิทยากร และความเหมาะสมของวิทยากรในภาพรวมมีความพึง

พอใจสูงสุดเทากัน ( x = 4.76) ความพึงพอใจดาน การอํานวยความสะดวก พบวาความพึงพอใจตอเร่ือง อาหาร,

                                                             
1

 เกณฑ์ในการวิเคราะห์ข้อมลู 
 เครืÉองมือมีลกัษณะเป็นมาตรประมาณค่า ŝ ระดับ กําหนดเกณฑ์ดังนี Ê 
 ค่าเฉลีÉย ř.ŘŘ – ř.ŝŘ หมายถึง มีความพงึพอใจในระดบัน้อยทีÉสดุ 
 ค่าเฉลีÉย ř.ŝř – Ś.ŝŘ หมายถึง มีความพงึพอใจในระดบัน้อย 
 ค่าเฉลีÉย Ś.ŝř – ś.ŝŘ หมายถึง มีความพงึพอใจในระดบัปานกลาง 
 ค่าเฉลีÉย ś.ŝř – Ŝ.ŝŘ หมายถึง มีความพงึพอใจในระดบัมาก 
 ค่าเฉลีÉย Ŝ.ŝř – ŝ.ŘŘ หมายถึง มีความพงึพอใจในระดบัมากทีÉสดุ 
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เคร่ืองดื่มและสถานท่ี มีความพึงพอใจสูงสุด ( x = 4.59) และความพึงพอใจในดานคุณภาพการใหบริการ พบวาความ

พึงพอใจตอทานไดรับความรู แนวคิด ทักษะและประสบการณใหมๆ จากการเขารวมโครงการ มีความพึงพอใจสูงสุด 

( x = 4.19) ดังตารางท่ี 6 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ตารางท่ี 6 

ความพึงพอใจเก่ียวกับการจัดกิจกรรมในดานตางๆ (N = 17) 

รายการ ระดับความพึงพอใจ2 x  ความหมาย 

มากท่ีสุด มาก ปานกลาง นอย นอย

ท่ีสุด 

 

1. กระบวนการ ข้ันตอนการใหบรกิาร 

1.1 การประชาสัมพันธโครงการฯ 29.4 

(5) 

58.8 

(10) 

11.8 

(2) 

- - 4.18 มาก 

1.2 ความเหมาะสมของสถานท่ี 59.2 

(9) 

41.2 

(7) 

5.9 

(1) 

- - 4.47 มาก 

                                                             
2

 เกณฑ์ในการวิเคราะห์ข้อมลู 
 เครืÉองมือมีลกัษณะเป็นมาตรประมาณค่า ŝ ระดับ กําหนดเกณฑ์ดังนี Ê 
 ค่าเฉลีÉย ř.ŘŘ – ř.ŝŘ หมายถึง มีความพงึพอใจในระดบัน้อยทีÉสดุ 
 ค่าเฉลีÉย ř.ŝř – Ś.ŝŘ หมายถึง มีความพงึพอใจในระดบัน้อย 
 ค่าเฉลีÉย Ś.ŝř – ś.ŝŘ หมายถึง มีความพงึพอใจในระดบัปานกลาง 
 ค่าเฉลีÉย ś.ŝř – Ŝ.ŝŘ หมายถึง มีความพงึพอใจในระดบัมาก 
 ค่าเฉลีÉย Ŝ.ŝř – ŝ.ŘŘ หมายถึง มีความพงึพอใจในระดบัมากทีÉสดุ 
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รายการ ระดับความพึงพอใจ2 x  ความหมาย 

มากท่ีสุด มาก ปานกลาง นอย นอย

ท่ีสุด 

 

1.3 ความเหมาะสมของระยะเวลา 

(จํานวนชั่วโมง, วัน) 

41.2 

(7) 

47.1 

(8) 

11.8 

(2) 

- - 4.29 มาก 

1.4 การจัดลําดับขั้นตอนกิจกรรม 41.2 

(7) 

52.9 

(9) 

 5. 9 

(1) 

- - 4.35 มาก 

รวม  4.32 มาก 

2. เจาหนาที่ผูใหบรกิาร/วทิยากร/ผูประสานงาน 

2.1 ความรอบรู ในเน้ือหาของ

วิทยากร 

76.5 

(13) 

23.5 

(4) 

- - - 4.76 มากท่ีสุด 

2.2 ความสามารถในการถายทอด

ความรู 

70.6 

(12) 

29.4 

(5) 

- - - 4.71 มากท่ีสุด 

2.3 ความสามารถในการตอบคําถาม 64.7 

(11) 

35.3 

(6) 

- - - 4.65 มากท่ีสุด 

2.4 ความเหมาะสมของวิทยากร ใน

ภาพรวม 

76.5 

(13) 

23.5 

(4) 

- - - 4.76 มากท่ีสุด 

รวม  4.72 มากท่ีสุด 

3. การอํานวยความสะดวก 

3.1 เอกสาร 41.2 

(7) 

41.2 

(7) 

17.6 

(3) 

- - 4.24 มาก 

3.2 โสตทัศนูปกรณ 41.2 

(7) 

47.1 

(8) 

11.8 

(2) 

- - 4.29 มาก 

3.4 อาหาร,เคร่ืองดื่มและสถานท่ี 58.8 

(10) 

41.2 

(7) 

- - - 4.59 มากท่ีสุด 

รวม  4.37 มาก 

4. คุณภาพการใหบรกิาร 

4.2 ความรูความเขาใจเก่ียวกับหัวขอ

เร่ือง หลัง เขารวมโครงการ 

29.4 

(5) 

52.9 

(9) 

17.6 

(3) 

- - 4.12 มาก 
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รายการ ระดับความพึงพอใจ2 x  ความหมาย 

มากท่ีสุด มาก ปานกลาง นอย นอย

ท่ีสุด 

 

4.3 ทานไดรับความรู แนวคิด ทักษะ

และประสบการณใหมๆ จากการเขา

รวมโครงการ 

37.5 

 (6) 

43.8 

 (7) 

18.8 

(3) 

- - 4.19 มาก 

4.4 ทานสามารถนําสิง่ท่ีไดรับจาก

โครงการ/กิจกรรมน้ีไปใชในการ

ปฏิบตัิงาน 

35.3 

(6) 

41.2 

(7) 

23.5 

(4) 

- - 4.12 มาก 

4.5 สิ่งท่ีทานไดรับจากโครงการ/

กิจกรรมคร้ังน้ีตรงตามความคาดหวัง

ของทานหรือไม 

23.5 

 (4) 

52.9 

 (9) 

23.5 

(4) 

- - 4.00 มาก 

4.6 ทานไดรับทราบแนวทางในการ

ถายทอดตัวชี้วัดและเปาหมายใน

องคกรไปสูระดับรายบคุคลไดอยางมี

ประสิทธิภาพ 

11.8 

(2) 

76.5 

(13) 

11.8 

(2) 

- - 4.00 มาก 

รวม  4.13 มาก 

4. ความพึงพอใจของทานตอ

ภาพรวมของโครงการ 

35.3 

(6) 

58.8 

(10) 

5.9 

(1) 

- - 4.29 มาก 

รวม  4.29 มาก 

รวมทั้งหมด  4.24 มาก 

 

 

 

 

ตอนที่ 3  

 

3.1 ส่ิงที่ทานพึงพอใจในการรวมโครงการครั้งน้ี 

1. วิทยากรบรรยายดีมาก 
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2. ความรูท่ีไดรับ 

3. การถายทอดความรูของวิทยากร 

4. หัวขอเปนประโยชนตอการพัฒนาคณะ  

5. มีเน้ือหาเก่ียวของกับการทํางาน วิถีชีวิตของคนทํางานของคณะ 

 

3.2  ส่ิงที่ควรเสนอแนะนําไปพัฒนาการจัดโครงการในโอกาสตอไป  (ในสวนของคณะ) 

1. หองประชุมหนาวเกินไป 

2. ระยะเวลาในการจัด 

3. ผูเขารวมประชุมควรเรียนเชญิและบังคับใหเขารวมจากทุกหนวยงานเพ่ือแลกเปลีย่นเรียนรูไดดยีิ่งขึ้น 

4. อาจตองระบุใหตวัแทนสาขาวิชาเขาฟงเพราะมีประโยชน 

 

 

 

 

 


